# Contents

Acknowledgments ............................................................................................................................... v

1 Lab 1 CS 121 Computation Lab I Fall 2009 Directions and Problems ......................................................... 1
  1.1 Overview .................................................................................................................................. 1
  1.2 Introduction to Lab 1 (20-25 minutes). ............................................................................................ 1
  1.3 Problems -- Part 1 (20 minutes) ..................................................................................................... 1
  1.4 Maple TA (15 minutes) ............................................................................................................... 5
    Notes on Maple TA ...................................................................................................................... 5
  1.5 Problems -- Part 2 (30 minutes) ..................................................................................................... 5
  1.6 Problems -- Extra Credit .............................................................................................................. 6
    Problem -- extra credit ................................................................................................................ 6
    Problem -- extra extra credit ...................................................................................................... 7
  1.7 Saving your work (5 minutes) ...................................................................................................... 7
  1.8 Final actions (End of class) .......................................................................................................... 7

2 Lab 2 Cs 121 Computation Lab I Fall 2009 Directions and Problems .......................................................... 9
  2.1 Lab 2 Overview .......................................................................................................................... 9
  2.2 Instructor's demonstration of exact and limited-precision arithmetic, scripting ............................ 10
  2.3 Part 1 ...................................................................................................................................... 10
    Problem 1 Description ................................................................................................................ 10
  2.4 Part 2 ...................................................................................................................................... 13
    Part 2 Description ...................................................................................................................... 13
  2.5 Final actions (end of class) .......................................................................................................... 14

3 Lab 3 Cs 121 Computation Lab I Fall 2009 Directions and Problems ......................................................... 15
  3.1 Lab 3 Overview ........................................................................................................................ 15
  3.2 Instructor's demonstration of textual entry of commands, use of lists and sets with plotting, and definition of functions .................................................................................................................. 16
  3.3 Part 1 ...................................................................................................................................... 16
    Part 1 Description ...................................................................................................................... 16
  3.4 Part 2 ...................................................................................................................................... 18
    Part 2 Description ...................................................................................................................... 18
  3.5 Attachment: starter script for Part 1 .............................................................................................. 19
  3.6 Final actions (end of class) .......................................................................................................... 23
Acknowledgments

To our colleagues and families, who supported us in trail-breaking.
To our students, who learn how to work with the new and different.
1 Lab 1 CS 121 Computation Lab I Fall 2009
Directions and Problems

1.1 Overview

This lab introduces the use of Maple, the primary computer language used for this course. You will learn how to do simple arithmetic calculations, as well as annotated plots. A ecology management problem is introduced that can be solved with the calculational facilities introduced.

This lab also introduces Maple TA, the primary homework/quiz/exam site for the course. You will log onto Maple TA with your personal account, and taking a practice quiz. Starting next week, there will be required/graded work on Maple TA for you to do.

1.2 Introduction to Lab 1 (20-25 minutes).

The instructor will introduce themselves and present a brief overview of course, Maple, and the lab.

The lab staff will hand out verification sheets along with paper copies of these directions. In later weeks, these directions will be posted on-line and can be read from your lab computer. The verification sheets will still be passed out, to be the permanent record of your attendance and accomplishments during the lab.

1.3 Problems -- Part 1 (20 minutes)

1. Sit down with your lab partner and if you haven't previously met, introduce yourself to them. Write both of your names down on the verification sheet in the space provided.

2. All of the partners should log onto a computer, following the demo given by the instructor in the introduction.

3. Do the calculations below. Everyone should try doing the computations on their own computer. To gain more confidence that you are getting the right answer, look at what your partners are getting. Get their help if they appear to be more successful than you. Sometimes just talking about what problems you are facing may produce useful insight towards overcoming them. If there is a problem that you can't collectively resolve, call the lab staff over and get some help.

4. You are to do all of the steps below. Some of the answers should be transcribed onto the verification sheet as indicated, for grading by the staff. Have a staff member come over to sign the verification sheet for part 1. Be prepared to show your work to the staff member, and to explain how you got your answers. This is also the opportunity to clear up any questions or uncertainties you may have even after doing the work.

5. When you complete part 1, get a staff member to verify your work before moving onto part 2.
1. a) Get Maple to calculate the sum of 2+2. Presumably you will be able to tell whether or not you got the right answer pretty easily.

b) What is exact fraction you get from adding together \( \frac{1}{2}, \frac{1}{3}, \) and \( \frac{1}{4} \)? What about the sum of \( \frac{1}{2}, \frac{1}{3}, \frac{3}{2}, \frac{4}{3} \) and \( \frac{5}{4} \)?

Note that if you are doing a calculation that is highly similar to a previous one, cutting and pasting can save you some effort entering the second expression.

2. Use Maple to perform the following exact calculations. To enter \( \pi \), you can select the letter from the Common Symbols palette on the left hand side of the Maple window (it's a few segments below the Expression palette). Note that Maple does not regard \( \Pi \) as the same as \( \pi \). To enter \( e \), the base of the natural logarithm, use the \( e^x \) from the expression palette, or the \( e \) from the "Common Symbols" palette. Typing "e" from the keyboard unfortunately does not produce the same result -- that kind of \( e \) Maple will regard as an symbol for an algebraic unknown like \( x \) or \( y \).

a) \[
\frac{1}{2} + \frac{1}{3} + \frac{47}{42}
\]

b) \[
\sin\left(\frac{\pi}{3}\right)
\]

c) \[\sqrt{\ln(8)}\] (You should get \( 2\sqrt{2} \).

d) \[\sqrt{1 + \frac{2}{5} + \frac{3}{15}}\] (You should get \( 2 \).

e) \[\log_{55}\left(\sum_{i=0}^{10} \right)\] (You should get \( 1 \).

3. A state lottery allows you to pick six numbers from the numbers from 1 to 52 to win. Maple exact arithmetic to calculate the exact odds of winning. This can be done by using the "choose" function from the expression palette: \( \binom{a}{b} \) means "the number of ways you can choose b things from a things". For example, if the lottery asked you to pick three numbers from the numbers from 1 to 6, the chances of winning would be 1 out of \( \binom{6}{3} = 20 \).

4. Calculate \( 2^{3^4} \). Note that \( 2^{3^4} = 8^4 = 4096 \). Why doesn't Maple give that as its answer?

5. Get Maple to reproduce this plot: \( \log_{10}\left(\sin\left(\frac{1}{x^2 + 1}\right)\right) \) →
You should use the right-click->plots->Plot Builder menu to specify things such as the plot range, the plot color, etc. Get Maple to reproduce this plot exactly, including the color and the proper horizontal and vertical ranges, and the title with the proper font size and style.

\[(x - 1) \cdot (x - 2)^2 \cdot (x - 5) \cdot e^{-\frac{x}{10}} \rightarrow\]
1.4 Maple TA (15 minutes)

1. The instructor will give a brief demo of how to use Maple TA, including how to log in, and how to take simple quizzes. (5 minutes)

2. Take Maple TA quiz 0. (10 minutes).

Notes on Maple TA

1. Maple TA is a quiz-administration system running separately from Blackboard Vista and Drexel One. Your userid should initially be your Drexel One userid (e.g. egk23) and the password should be your Drexel student ID number (e.g. 10096739). Note that the password is probably Drexel One password. You can change your Maple TA password after you log in.

2. The address for Maple TA will be given in class. Links to it will also appear on the class web site www.cs.drexel.edu/cs121/Fall2009 as well as the class site on Blackboard Vista, under "Maple TA".

3. After logging onto Maple TA, you need to select the correct class, and then the correct test to take. Usually your choices will be limited, but the choices may change during the term depending on the need.

4. After you have finished answering all the questions, you should hit the "Grade" button so that your score is recorded. If you don't do this this, Maple TA will record your answers but you will receive no credit for your work because your recorded score will remain at 0.

5. If you encounter any technical difficulties, you should contact the course staff by visiting the Cyber Learning Center (University Crossings 147) or on-line in the Blackboard class discussion group. If you have questions about the grading of an Maple TA assignment, you should contact your section instructor (the person listed in the schedule of courses).

6. The quiz server will only handle 150 simultaneous users and will turn away the excess, so don't wait until the last moment to take the quiz. You will be given credit for only that part of the quiz that you finish before the deadline. 7. If there is a catastrophic system failure, the deadline will be adjusted. An announcement will be made on Blackboard and the course website.

1.5 Problems -- Part 2 (30 minutes)

Complete part 1 problems if you haven't finished. Then work on part 2 of Lab. Get verification.
1. Find the exact solution to \( 3x + 5 = 0 \).

2. Find the exact solution to \( a \cdot x^2 + b \cdot x + c = 5 \) (solve for x).

3. From Anton, Calculus, 8th edition, ch. 1 review exercises, problem 37, p. 99. A breeding group of 20 bighorn sheep is released in a protected area in Colorado. It is expected that with careful management the number of sheep, \( N \), after \( t \) years will be given by the formula:

\[
N = \frac{220}{1 + 10 \cdot (0.83)^t}
\]

and that the sheep population will be able to maintain itself without further supervision once the population reaches a size of 80.

(a) Graph \( N \) versus \( t \). (b) How many years must the state of Colorado maintain a program to care for the sheep? Show your work. (c) How many bighorn sheep can the environment in the protected area support? (hint: examine the graph for large values of \( t \).)

### 1.6 Problems -- Extra Credit

Only do these problems if you are far ahead of everyone else. You can get a little extra credit for them.

**Problem -- extra credit**

Do this for Lab extra credit if you have finished parts 1 and 2 with plenty of time to spare. In general, doing extra credit will bump your score for this lab beyond 100%. The final grade for the course includes the weighted sum of lab grades for this course, so by doing extra credit you will be smoothing out any deficiencies you may be incurring in other parts of the course such as the exam or the quizzes. Unless stated otherwise, extra credit is available only if done in the student's assigned lab session, and is not available in make-up labs. It may be possible to get partial extra credit even if you do not completely finish the extra credit work.

Explore a mathematical phenomenon jotting notes and observations as you go. In a fresh Maple document, show the trail of your computation and your written explanation of what you found and how you found it. Here's the problem. Consider the following sequence of expressions:

\[
\begin{align*}
&\frac{1}{2} \\
&\frac{1}{2 + \frac{1}{2}} \\
&\frac{1}{2 + \frac{1}{2 + \frac{1}{2}}} \\
&\frac{1}{2 + \frac{1}{2 + \frac{1}{2 + \frac{1}{2}}}}
\end{align*}
\]

What is the next number in the sequence?

What is the next one after that?

Can you predict what the next one after that is without computing it first? Write down your prediction and your reasons for it.
Problem -- extra extra credit

If you've finished the extra credit problem, this one may take a little longer to do. It is meant for people who already know something about recursive programming or recurrence relations -- or who are superaccurate typists. What is the 47th number in the sequence? (We aren't interested in approximations, we want the exact fraction.) If you've finished the extra credit problem in the lab, then come back in two weeks with the answer to this problem and an explanation of how you can with just a little more computer time and no more typing get almost any number in the sequence, and you will get three points extra extra credit.

You will get five points extra extra credit if you use Maple to get the 47th number, or any other number in the sequence.

1.7 Saving your work (5 minutes)

1. The instructor will demo how to save a Maple worksheet file, and how to upload the work to Blackboard (occasionally required for some labs).

2. Save your work into a .mw file. The resulting file should show up on your Desktop, although it depends on your computer's notion of current working directory. If you have problems finding the file on the Desktop and your partners can't help you, call over a staff member. After saving the file, upload a copy of the file to Blackboard so that you can refer to it later on. (Most public computers at Drexel automatically wipe out all files created during a student session after the student logs out.) Ask a lab staff member for a demo of this if they haven't done it already. You can also send yourself a copy via email as an attachment. This is good for those who want to remember how they did things, or wish to look at the worksheet again after lab. If you upload the file to Blackboard, you can download it to your home computer from there.

1.8 Final actions (End of class)

1. Before you leave, get the staff to grade, sign, and collect the verification sheet. You don't get credit for the lab unless they have a score recorded for you in a signed verification sheet that they have at the end of lab. You may leave the lab after you do this. You can get partial credit for the lab if a portion of your work is verified.

2. Final grades for the course will be curved if necessary, so don't fret excessively if you don't finish but it looks like others are in the same shape. However, you should try to learn the material you don't complete in lab so that you can pass the quizzes and be ready for the next lab. Computer work at this introductory level introduces a lot of ideas and concepts that appear pervasively in subsequent work. The plus side is that you'll probably see next time more of what you worked on this time, so you'll have another chance to practice and improve. The down side is that you can't ignore tough details and hope that they won't matter much.
2 Lab 2 Cs 121 Computation Lab I Fall 2009
Directions and Problems

2.1 Lab 2 Overview

Overview

This lab practices the development of re-usable multi-step scripts to solve a problem.

Before beginning lab work, you will also see the instructor demonstrate elements of floating point and exact arithmetic. As explained by Chapter 3 of the course readings, the way Maple (and most other systems that use "calculator" numbers) works with floating point numbers is a bit different from what you learn in mathematics courses.

Part 1 of the lab has you apply a given script to solving various versions of a problem. Part 2 has you developing your own script and applying it. In the latter, you must do three "original" things: a) identify the parameters of the problem, b) develop a solution, and then c) apply your script to the other versions of the problem by cutting and pasting.

Directions for this lab

1. Find a lab partner. You need not use the same partner as last time. Group members should introduce themselves to each other if they haven't already met.

2. Listen to the instructor's overview of this week's new concepts and Maple features.

3. Get your copy of the verification sheet and check out which parts of the work will be verified.

4. Work on part 1 (30 minutes), and part 2 (50 minutes). We would like to see everyone end up with individual copies of the solution scripts. However, it may be more efficient this time to work as a pair at a single computer, and distribute the scripts to both partners via email or other file exchange at the end.
2.2 Instructor's demonstration of exact and limited-precision arithmetic, scripting

Limited-precision and exact numbers, arithmetic

The instructor will demonstrate:

the difference between the way exact and limited-precision numbers *look*.
the difference in the way Maple does arithmetic with exact numbers, and with limited-precision numbers
what happens when you exercise common commands such as *solve* with floating point (limited-precision) and exact numbers

Scripting and script-building

After this, the instructor will quickly review the work required in the scripting portion of the lab. It is expected that you will have read Chapters 3 and 4 of the course readings before coming to lab and are already familiar with the assignment (*:=*) operation, the concept of parameters in a script. If you've worked through the examples given in chapter 4 of a script and how to build one from a problem description, you should find the work in the lab straightforward.

2.3 Part 1

Problem 1 Description

1. Consider the following three versions of a problem:

<table>
<thead>
<tr>
<th>Version 1</th>
<th>Version 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>A package of medical supplies is dropped from a helicopter straight down by parachute into a remote area. The velocity $v$ (in feet per second) of the package $t$ seconds after it is released is given by the equation $v = 24.61 (1 - e^{-1.3 \cdot t})$. (a) Graph $v$ versus $t$. (b) What is the horizontal asymptote of the graph? (c) How long does it take for the package to reach 98% of its terminal velocity?</td>
<td>A different package (with a different aerodynamical configuration) is dropped from a helicopter. The velocity $v$ (in feet per second) of the package $t$ seconds after it is released is given by the equation $v = 27.47 (1 - e^{-1.1 \cdot t})$. (a) Graph $v$ versus $t$. (b) What is the horizontal asymptote of the graph? (c) How long does it take for the package to reach 87.5% of its terminal velocity?</td>
</tr>
</tbody>
</table>
A different package (with a different aerodynamical configuration) is dropped from a helicopter. The velocity $v$ (in feet per second) of the package $t$ seconds after it is released is given by the equation

$$v = 22.47(1 - e^{-1.47t})$$

(a) Graph $v$ versus $t$.

(b) What is the horizontal asymptote of the graph?

(c) How long does it take for the package to reach 47.47% of its terminal velocity?

a) Do File -> New -> Document to get a fresh blank Maple worksheet. At the top of the document, insert the names of your group members, your lab section, your lab instructor's name, and the date/time. Then enter the following sequence of commands to solve version 1 of the problem. In some cases you'll have to figure out what you do with the right-click menu to get the effect.

For verification on this part, you should be able to identify the parameters of the problem (and explain why they, and not other variables in the script are parameters. Save this script as Lab2Part2.1.1.mw.
Version 1
Define the basic relationship between time and velocity. We use parameters a and b to represent the coefficients in the equation. We use the parameter p to represent the percentage of terminal velocity that we want to hit.

\[ a := 24.61 \]  
\[ b := -1.3 \]  
\[ p := 0.98 \]  

Enter the equation and assign it to the name eqn.

\[ \text{eqn} := v = a \left( 1 - e^{b \cdot t} \right) \quad \text{right hand side} \quad 24.61 - 24.61 e^{-1.3 \cdot t} \quad \text{assign to a name} \quad \text{rhseqn} \]

Plot this expression to better understand it. You will have to fiddle with the plot builder (not shown) in order to get the axis and title labeling set up correctly.

\[ \text{rhseqn} \quad 24.61 - 24.61 e^{-1.3 \cdot t} \rightarrow \]

\begin{figure}
\centering
\includegraphics[width=0.5\textwidth]{velocity_graph.png}
\caption{Velocity versus time}
\end{figure}

\texttt{print(???);}  # input placeholder
%

The horizontal asymptote is the limit as \( t \) goes to infinity of the right hand side of the equation. Don't worry too much if the mathematical notation for getting the asymptote seems unfamiliar; the important thing to note is that Maple can figure it out if you learn how to fill in the "lim" template from the expression palette.

\[ \text{terminalVelocity} = \lim_{t \to \infty} \text{rhseqn} \]
\[ 24.61000000 \]  

Compute the fraction of terminal velocity wanted by this version of the problem and assign it to another variable. \( \text{fracTV} \) is not a parameter of the problem since it depends on derived values as well as other parameters.
\texttt{fracTV := p-terminalVelocity}

\begin{equation}
24.11780000
\end{equation}

Set up the target equation that equates the fractional velocity to the velocity expression, and solve it numerically.

\texttt{fracTV = rhsseqn}

\begin{equation}
24.11780000 - 24.61 - 24.61 e^{-1.3 t}
\end{equation}

\texttt{solve}

\begin{equation}
3.09248466
\end{equation}

Evidently it takes \((1.3, 1.9) = 3.09248466\) seconds to attain \(p \cdot 100 = 98.00\%\) of terminal velocity.

\textbf{b)} Once you have gotten version 1 of the script running successfully, copy the script into a new document (File -> New -> Document). Change the parameter values to configure the script to solve version 2 of the problem. Execute the new document. Check that it solves version 2 of the problem (how will you do that?). Save this script as Lab2Part2.1.2.mw. \textbf{(Note:} there appears to be a bug in the "execute selection" operation that causes extra unwanted plots to be generated sometimes. However, it's easy enough to delete those after you get the solution.). In order to get credit for this part, you have to be able to show to the graders that all you did to the script from part a) was to edit the value of the parameters, and then executed the whole worksheet. You shouldn't need to modify any of the formulas, the solve or plot commands, etc. That is, the only lines of the script that you are permitted to alter are the initial lines establishing the values of the parameters.

c) Do it again for Version 3 of the problem. Save this script as Lab2Part2.1.3.mw.

\section*{2.4 Part 2}

\textbf{Part 2 Description}

(From Hodge and Luck, "Using Computation Software Root Solvers", \textit{Computers in Education Journal}, American Society for Engineering Education, No. 2, vol 18, June 2009, p. 81-92.) The normalized amplitude \(A\), of the vibration of a door panel of an automobile is found to be

\[ A = \frac{1}{\sqrt{\left(1 - \left(\frac{\omega}{\Omega_f}\right)^2\right)^2 + c^2 \left(\frac{\omega}{\Omega_f}\right)^2}} \]

where \(c\) is a measured constant that depends on the car, \(\omega\) is the number of revolutions per second of the motor, and \(\Omega_f\) is the measured frequency of vibration of the door panel in cycles per second.

Consider the following three versions of the problem.
Version 1
We find that for a 2009 Camaro (yellow, of course), \( c = 0.15 \) , and \( \Omega_y = 20 \) Hz. (a) Display a reasonable graph of engine speed (in revolutions per minute) versus amplitude. (b) Calculate the speed of the engine (in rpm) for which the normalized amplitude is 2.

Version 2
We find that for a 2003 Mini Cooper, \( c = 0.18 \), and \( \Omega_y = 25 \) Hz. (a) Display a reasonable graph of engine speed (in revolutions per minute) versus amplitude. (b) Calculate the speed of the engine for which the normalized amplitude is 2.7.

Version 3
We find that for a 1984 Ferrari 308 (red), \( c = 0.11 \), and \( \Omega_y = 15 \) Hz. (a) Display a reasonable graph of engine speed (in revolutions per minute) versus amplitude. (b) Calculate the speed of the engine for which the normalized amplitude is 1.5.

In a fresh document enter a script similar in style to that of Problem 2.1, to solve Version 1 of this problem. Name this document Lab2Part2.2.1.mw. Another thing to think through is how to get the answer in revolutions per minute rather than revolutions per second. You will need to establish the plotting limits by making some trial plots until you get a range that seems to be in the right ballpark.

Once you have that working, create two more documents that solve Versions 2 and 3 of the problem, called Lab2.Part2.2.2.mw and Lab2.Part2.2.3.mw.

Why were these particular cars chosen for the example?

2.5 Final actions (end of class)

Upload all of your work to Blackboard, or email copies to yourself and/or your partners.
3 Lab 3 Cs 121 Computation Lab I Fall 2009
Directions and Problems

3.1 Lab 3 Overview

Overview

This lab introduces more features of Maple that can be used for scripts that compute solutions to technical problems: lists, textual specification of commands to solve and plot, the use of functions including user-defined functions. It also introduces a data-fitting feature.

Before beginning lab work, you will also see the instructor demonstrate how to use these elements. The jump to textual entry of an entire Maple operation takes some getting used to, but the flexibility and power of expression is needed to do sophisticated technical problems.

Part 1 of the lab has you apply a given script to solving various versions of a problem. You then are presented with a variation of the problem and asked to modify the script to solve the variant. The original work here is to determine how to solve the variant given the solution technique presented by the script in the original version, and then

In the latter, you must do three "original" things: a) identify the parameters of the problem, b) develop a solution, and then c) apply your script to the other versions of the problem by cutting and pasting.

Directions for this lab

1. Find a lab partner. You need not use the same partner as last time. Group members should introduce themselves to each other if they haven't already met.

2. Listen to the instructor's overview of this week's new concepts and Maple features.

3. Get your copy of the verification sheet and check out which parts of the work will be verified.

4. Work on part 1 (30 minutes), and part 2 (40 minutes). We would like to see everyone end up with individual copies of the solution scripts. However, it may be more efficient this time to work as a pair at a single computer, and distribute the scripts to both partners via email or other file exchange at the end.
3.2 Instructor's demonstration of textual entry of commands, use of lists and sets with plotting, and definition of functions

Textual entry of Maple commands, lists, sets, and plots

The instructor will demonstrate:

How to invoke `solve` and `plot` with textual entry of the function, including the use of lists and sets. Ways of troubleshooting your way out of problems with textual entry will also be demonstrated.

Use of functions and defining your own functions

The instructor will review the available functions in Maple, where to read more about them, and how to define your own. Use of a user-defined function in a script will also be shown.

3.3 Part 1

Part 1 Description

From notes on Time Constants, ENGR 101 Fall 2009 (week 3)

A capacitor connected to a battery charges according to the following formula

\[ V(t) = T[i] + (T[a] - T[i])(1 - e^{-kt}) \]

where \( T[i] \) is the starting voltage, \( T[a] \) is the final voltage, and \( k \) is the reciprocal of the time constant. The voltage is measured in volts, the time in seconds.

Here is a problem that can be solved by a Maple script:

<table>
<thead>
<tr>
<th>Problem A, Version 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>For a particular capacitor/battery set up, we find ( T[i]=63, T[a]=266, k=0.09. )</td>
</tr>
<tr>
<td>(a) What is the value of ( \tau ), the time constant?</td>
</tr>
<tr>
<td>(b) What is the voltage after 20 seconds?</td>
</tr>
<tr>
<td>(c) What is the voltage after 40 seconds?</td>
</tr>
<tr>
<td>(d) How long does it take the voltage to reach 256 volts? Plot the voltage curve and a horizontal line whose intersection gives a visualization of when this happens</td>
</tr>
<tr>
<td>(e) What percentage of the difference in voltage has the capacitor been charged to after ( \tau ) seconds?</td>
</tr>
</tbody>
</table>

Directions, Part 1

1. Download the file Lab3Part1Script.mw and open it.

2. Do Edit->Execute->Worksheet and execute the worksheet. Verify that it's working correctly by comparing the output to what you believe is the correct answer.
3. Modify the worksheet to run the following version of the problem:

**Problem A, Version 2**
For a particular capacitor/battery set up, we find $T[i]=37$, $T[a]=251$, $k=0.0075$.
(a) What is the value of $\tau$, the time constant?
(b) What is the voltage after 60 seconds?
(c) What is the voltage after 120 seconds?
(d) How long does it take the voltage to reach 220 volts? Plot the voltage curve and a horizontal line whose intersection gives a visualization of when this happens
(e) What percentage of the difference in voltage has the capacitor been charged to after $\tau$ seconds?

After you make your changes to the worksheet's parameters, you can do Edit->Execute->Worksheet to run the whole thing again. Verify that the worksheet is still working plausibly.

4. Here is a similar but different problem. Figure out how to solve the problem, and then modify the previous script to solve this problem. You will need to do more than change the parameter values, you will have to change the instructions that occur in the script. The modifications revolve around figuring out what you want to solve for $k$. That in turn will cause you to change which parameters the script has. Because of the great similarity between the problems, it's easier to edit a copy of your original script than to type things in all over again.

This happens all the time in programming -- once you have something successful, you run into variations that require reprogramming rather than just re-execution of a fixed script.

**Problem B, Version 1**
For a particular capacitor/battery set up, we find $T[i]=37$, $T[a]=251$.
(a) We find that after 25 seconds, the voltage has risen from its initial value to 72.0 volts. What is the value of $k$?
(b) What is the value of $\tau$, the time constant?
(c) What is the voltage after 40 seconds?
(d) What is the voltage after 60 seconds?
(e) How long does it take the voltage to reach 220 volts? Plot the voltage curve and a horizontal line whose intersection gives a visualization of when this happens
(f) What percentage of the difference in voltage has the capacitor been charged to after $\tau$ seconds?

5. Change the title/header of the script to indicate that it solves a different problem. Change individual lines of the commentary within the script where you have altered actions. Save a copy of this modified script as Lab3Part1AnswerB1.mw on the desktop. Send a copy of it to yourself and to your lab partner through email.

6. Verify that you've done an adequate job of parameterizing by using your script from (4) to solve this version of the problem.
**Problem B, Version 2**

For a particular capacitor/battery set up, we find $T_i = 30$, $T_a = 274$.

(a) We find that after 30 seconds, the voltage has risen from its initial value to 101.0 volts. What is the value of $k$?

(b) What is the value of $\tau$, the time constant?

(c) What is the voltage after 40 seconds?

(d) What is the voltage after 60 seconds?

(e) How long does it take the voltage to reach 220 volts? Plot the voltage curve and a horizontal line whose intersection gives a visualization of when this happens

(f) What percentage of the difference in voltage has the capacitor been charged to after $\tau$ seconds?

7. Save this version of the script as Lab3Part1AnswerB2.mw on the desktop. Send a copy of it to yourself and to your lab partner through email.

### 3.4 Part 2

#### Part 2 Description

Sometimes rather than plotting points of a function, we are given data points taken from measurements and want to find a function that would produce them. One additional issue is that the data is typically precisely accurate, there is experimental error in making the measurements. So we are satisfied if the function we derive is "reasonably close" to the data points rather than passing exactly through them. This is called the data fitting problem.

Typically rather than searching through all possible functions to find the best fit, we look for good candidates from a particular class of functions. One class are the linear functions: all functions $g(x) = a \cdot x + b$ for some values $a$ and $b$. The data fitting problem becomes that of finding good values of $a$ and $b$.

There are several techniques for doing data fitting. One of the more popular is called least squares data fitting.

The data points $(x_1, y_1), (x_2, y_2), \ldots, (x_n, y_n)$ can of course be split into two separate lists of values, $x$ written as $[x_1, \ldots, x_n]$ and $y$ written as $[y_1, \ldots, y_n]$.

#### Problem C, Version 1

(From Anton, Calculus 8th ed., p. 1007)

If a gas is cooled with its volume held constant, then it follows from the ideal gas law in physics that its pressure drops proportionally to the drop in temperature. The temperature, that, in theory, corresponds to a pressure of zero is called absolute zero. Suppose that an experiment procues the following data for pressure $P$ versus temperature $T$ with the volume held constants:

<table>
<thead>
<tr>
<th>$P$ (kiloPascal)</th>
<th>134.2</th>
<th>142.5</th>
<th>155.0</th>
<th>159.8</th>
<th>171.1</th>
<th>184.2</th>
</tr>
</thead>
<tbody>
<tr>
<td>$T$ (deg Celsius)</td>
<td>0</td>
<td>20.1</td>
<td>39.8</td>
<td>60.0</td>
<td>79.9</td>
<td>100.3</td>
</tr>
</tbody>
</table>

We want to find values $a$ and $b$ so that the line described by $a \cdot t + b$ does a good job of representing the data. Then we will use the formula we get for $P$ to answer some questions.

1. Create a fresh Maple session through File->New->Document mode.
2. Enter two lists. Call the first list pData and assign it the numbers found in the first row of the above table: pData := [134.2, 142.5, 155.0, 159.8, 171.1, 184.2]. Similarly, create a second list and assign it to tData.

3. Produce a point plot with Maple using the techniques discussed in chapter 5 of the course readings. Make the plot blue.

4. Look up the data fitting facility in maple by starting up Maple help and looking up "least squares". Find the examples given in the documentation page on CurveFitting[LeastSquares] and see one that will help you do data fitting using pData, and tData. Produce a formula for the line. Notes: (a) You will have to experiment in order to get things to work. Start by copying and pasting the instructions from the examples and getting them to work as advertised in your own worksheet. Then try substituting pData and tData for the values in the example. (b) The "with(CurveFitting):" operation needs to be done before you can do any of the other lines in the examples. (c) You don't have to use "v" as the variable in the curve fitting formula. It makes more sense to use "T". (d) In the work to come, it helps to give the formula produced by the curve fitting a name, through assignment.

5. Plot the line you got from (d). Make the line blue.

6. Here's a trick to do a quick multi-plot that's not documented in the chapter readings. (a) copy the point plot to the bottom of the worksheet. (b) copy the formula plot. (c) click on the copy of the point plot. (d) right-click and select "paste". It works for a one-of plot but it doesn't lend itself to scripting very easily. The combined plot should show the line passing close by most of the data points. If it doesn't this is an indication that something is wrong.

7. Once you have gotten a least squares formula, answer the following questions:

(a) Based on the formula, get Maple to estimate the pressure when the temperature is 120 degrees Celsius by evaluating the expression at $T=120$. (The eval operation is handy here).

(b) Produce an estimate for absolute zero (where pressure is zero) by solving an equation involving this formula. What is your estimate? Look up the actual value of absolute zero on the Internet and compare it with your estimate from this "virtual experiment". Include to calculated answer in a textual explanation of what you are doing, similar to the way that the target voltage was mentioned in the script for Part 1.

8. Save your worksheet for part 2 as Lab3Part2Solution.mw and mail copies of it to yourself and your lab partner. Be sure to put the names of your team on the worksheet for easy identification.

9. Re do this problem with Tools->Assistants->Curve Fitting. You will want to select "least squares" as the technique for fitting, not splines or interpolation. Be prepared to show your worksheet and the solution with the assistant to the staff for grading. Which way was easier for you to do?

3.5 Attachment: starter script for Part 1

Script for Lab 3, Part 1

CS 121 Computation Lab I

Fall 2009

This script was run by: (fill in here).

This script solves the following problem:

A capacitor connected to a battery charges according to the following formula
\[ V(t) = T[i] + (T[a] - T[i])(1 - e^{-kt}) \]

where \( T[i] \) is the starting voltage, \( T[a] \) is the final voltage, and \( k \) is the reciprocal of the time constant. The voltage is measured in volts, the time in seconds.

**Problem A, Version 1**

For a particular capacitor/battery set up, we find
\( T[i]=63, \ T[a]=266, \ k=0.09. \)

(a) What is the value of \( \tau \), the time constant?
(b) What is the voltage after 20 seconds?
(c) What is the voltage after 40 seconds?
(d) How long does it take the voltage to reach 256 volts? Plot the voltage curve and a horizontal line whose intersection gives a visualization of when this happens
(e) What percentage of the difference in voltage has the capacitor been charged to after \( \tau \) seconds?

**Start of parameters**

\[ T[i] := 63 \]
\[ T[a] := 266; \]
\[ k := 0.09 \]
\[ t1 := 20 \]
\[ t2 := 40 \]
\[ vTarget := 256 \]

**End of parameters**

Define a function that describes the voltage. This is not a parameter because it doesn't change between versions of the problem.
\[ V := t \rightarrow (T[i] + (T[a] - T[i]) \cdot (1 - \exp(-k \cdot t))) \]
\[ t \rightarrow T_i + (T_a - T_i) \left(1 - e^{-k \cdot t}\right) \]  
(3.7)

Test the function at \( t=0 \) -- should be initial voltage.

\[ V(0) = 63. \]  
(3.8)

According to the notes, the time constant is the reciprocal of \( k \).

\[ \tau := \frac{1}{k} \]
\[ 11.1111111 \]  
(3.9)

Since we have defined \( V \), all we have to do is evaluate \( V \) at \( t=20 \) and \( t=40 \).

\[ V(t1) = 232.4443257 \]  
(3.10)

\[ V(t2) = 260.4532844 \]  
(3.11)

To find how long it takes to reach the target voltage, we evaluate \( V \) at the symbol \( t \), and equate it to the target voltage. Solving that equation for \( t \) will give us the answer.

\[ eqn := vTarget = V(t) \]
\[ 256 = 266 - 203 e^{-0.09 \cdot t} \]  
(3.12)

The target voltage is reached in \( \text{solve(eqn, } t) = 33.45134318 \) seconds.

To do a plot which gives the same kind of answer, plot \( V \) and a horizontal line (a "constant function") whose value is the target voltage. The intersection of the two lines indicates where the voltage reaches the target. For the range, we pick ten times the time constant, which should be enough to see the exponential curve go into its "almost flat" phase. After all, when \( t \) is equal to ten times the time constant, \( V(t) \) should achieve \( 1 - (1 - .632)^{10} = 0.9999544511 \) of the final voltage \( T[a] \).
vdiff is the difference between starting and final voltage

\[ vdiff := T[a] - T[i] \]  

(3.13)

vgain is the difference between the starting voltage and the voltage at \( t = \tau \)

\[ vgain := V(\tau) - T[i] \]  

128.3204734  

(3.14)

percentGain is the percentage gain -- a decimal number between 0 and 1.

\[ \text{percentGain} := \frac{vgain}{vdiff} \]  

0.6321205586  

(3.15)

End of script
3.6 Final actions (end of class)

Upload all of your work to Blackboard, or email copies to yourself and/or your partners.